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in Fluid Power, Energy and Power, Dimensional Metrology, Quality Assurance, Manufacturing Productivity and Data Analysis and Decision Making in
Industrial Technology. He is also the academic
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of the Fluid Power Society.

Introduction
Fluid Power in one manner, shape,
or form is found in most Industrial
Technology curriculum. It may be taught
under other names such as Industrial
Hydraulics, Hydraulics and Pneumatics,
or Industrial Hydraulics and Pneumatics.
Regardless of its name, the main intent of
this course is to provide students with a
fundamental understanding of fluid
power concepts with an emphasis on the
physical properties of fluids, component
design and operation, and circuit design
and analysis.
In fluid power instruction various
techniques and training aids are used to
promote understanding and learning.
Many of the techniques and aids used
and the rationale for their incorporation
include: (a) manual or computer-based
calculations to promote an understanding of the principles of system and
component operation; (b) visual and
schematic displays to promote an
understanding of component design
and construction; and (c) hydraulic and
pneumatic trainers to promote handson experiences with working systems.
Since the development of an
understanding of system principles and
design involves mathematical calculations, a spreadsheet program can be
used to show time savings capabilities
of custom-designed templates. Consequently, it is the intent of this paper to
demonstrate various ways in which

spreadsheet templates and spreadsheetbased data analysis can be incorporated
into fluid power instruction. It should
be noted that no attempt will be made
at this time to compare and contrast
instructional approaches or software
packages both generic as spreadsheets
or hydraulic-specific as Automation
Studio and HydraCalc; each approach
and software has its own merits and
advantages provided the emphasis is
effective and meaningful integration.

Spreadsheet Program Selection
and Integration
Although there are a multitude of
spreadsheets programs available today,
only two would probably be considered
for fluid power integration, Microsoft
Excel or Lotus. Experience has shown
that Excel should be given integration
consideration for three reasons: (a) it is
an inherent part of the Microsoft Office
suite to which many universities,
departments, and students hold license
to; (b) its extensive charting and
graphing capabilities; and (c) its data
analysis capability. If students are
familiar with spreadsheet basics, only a
review of the following would normally
be needed to get them up and running
with fluid power-based templates.
• entering formulas and text;
• using and integrating functions;
• creating tables, graphs, and charts.
Designing hydraulic and pneumatic
systems requires many simple calculations. Spreadsheet templates, once
constructed, are a very appropriate tool
for performing these calculations. With
respect to entering formulas, students
should be reminded that the “=“ sign
must be entered prior to formula entry;
without it, all formulas will be treated as
text and will not be able to perform their
intended purpose. Functions, on the
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other hand, are special purpose, formula-based expressions. Microsoft
Excel User’s Guide (1994) indicated
that there are over 300 functions that are
divided into 12 categories for ease of
selection. The function selection dialog
box is accessible by selecting functions
under the Insert menu. A useful aid
incorporated with the function selection
dialog box is a sample expression of the
way in which the function must be
entered and a short description of its
intended use.
Middleton (1997) indicated that the
visual display of data in charts and
graphs is an important aspect of any
analysis. Chart and graph creation using
table information is relatively easy in
Excel through the use of the chart
wizard. Various procedures for generating effective charts and graphs that
incorporate a pleasing appearance and
integration with established tables
include (a) using the “on this sheet”
option instead of the “on new sheet”
option when creating new charts and
graphs; (b) including column and row
labels in charting cell range for automatic
axis labeling; (c) selecting the appropriate chart type (line, XY scatter, etc.) for a
given table data; (d) resizing of charts or
graphs for effective integration with
existing tables; and (e) determining
internal chart formatting, items such as
legend information inclusion or exclusion, number formatting, label orientation
and sizing, and axis scaling.

Fluid Power Problem-Solving
Using Spreadsheet Templates
One of the most powerful facets of
a spreadsheet program is its “what if”
analysis capability. Academic business
departments have known of and
utilized this capability for many years.
If a spreadsheet template is designed
with the intent of conducting “what if”
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analyses and incorporates proper cell
referencing and input data structuring,
the usefulness of the template can be
significantly increased. One of the
principal advantages of the “what if”
analysis structure is the overall time
savings it provides; tedious and
repetitive manual calculations are not
required. Most templates that are
designed and constructed for integration in fluid power instruction will
automatically possess this capability to
varying degrees and can be modified to
further enhance this capability.
Two examples that demonstrate the
use and application of spreadsheet
templates in fluid power instruction can
be seen in Problem-Solving Templates
1 and 2. Although both of these
templates have given values in their
problem statements and questions, the
structure of the templates permit the
entry of any value into the “givens”
cells as well as the automatic recalculation of new solution values
using new “given,” provided cell
formulas and references are entered
correctly. Another aspect of these
templates that should be noted is their
step-by-step solution approach (single
formula calculations). This approach
was used solely for instructional
purposes. In reality, most experienced
template designers would combine
multiple solution steps into a singlestep formula expression.

Regression Analysis of Fluid
Power Data
Simple and multiple regression
(macro-based) is an important aspect of
analysis and is available in Excel
through the Data Analysis option under
the Tools menu or through the Add-ins
option under the Tools menu, if Data
Analysis is not listed as a Tools option.
Simple regression analysis is also
available using the Trendline option in
Excel. This option, sometimes referred
to as trend forecasting, is a graphicsbased approach for conducting simple
regression analyses. The usefulness of
the trendline analysis lies in the ability
of users to know when and how to
incorporate and utilize the different
regression analyses. Figures 1 and 2
indicate, respectively, the trendline

types and display options available
within Excel.
As mentioned previously, it is
important for users to develop an
understanding of the ways in which
each of the trendline types can be used.
For example, a comparison of Rsquared values of four trendline types
(linear, power, logarithmic, and
exponential) can be performed to
determine the regression method that
yields the maximum accountability of
variability (the greater the accountabil-
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ity, the greater the validity of the
regression equation). To begin the
trendline analysis process, an XY
scatterplot of the data is needed. The
scatterplot is not only a necessary first
step in the trendline analysis process
but it can also be used to determine if a
regression analysis data is actually
warranted. An added advantage of the
trendline analysis is that the regression
equation and R-squared value can be
incorporated on the chart of the plotted
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data and will automatically update if
there is a change in the data set.
An example that demonstrates the
effectiveness of the trendline analysis
and R-squared comparison technique
can be seen in an attempt to simplify
the relationship between pressure,
force, and area (PFA). As indicated in
published textbooks, Industrial Hydraulics Manual (1992) and Esposito
(1998), the PFA relationship is characterized through the following equation:
Pressure (P) = Force (F) / Area (A).
This formula is used extensively to
determine system pressure requirements given a particular cylinder/piston
diameter and output force requirement;
variations of the formula are also used
to conduct reverse order calculations.
Regardless of the formula variation
used, one aspect of all PFA calculations
is the need to convert cylinder/piston
diameter to an area. Since this conversion aspect adds an additional calculation to the entire process [ Area (A) =
0.7854 * Diameter 2 ], a simplified,
single-step formula expression would
be desirable. To determine the feasibility of establishing a simplified, singlestep expression incorporating pressure,
force, and diameter (PFD) variables,
the following four-step analysis was
conducted.
Step 1A: Establishing Primary Variables and Data. To begin the analysis
process, four columns of data were
generated. Diameter data was selected
in increments of 0.25 inches starting
with one inch and ending at six inches.
Area data was calculated from the
diameter data and used, along with the
test force value of 500 lbs, to calculate
theoretical pressure values. Diameter
and Theoretical Pressure data were
labeled as X and Y variables, respectively, for use in the Step 1B regression
analysis.
Step 1B: Conducting Regression
Analysis of Diameter (X) and Pressure
(Y) @ Force = 500 lbs. The basis for
this analysis was to determine the
extent of the relationship between the
identified X and Y variables as well as
a valid regression approach and
equation. It should be noted that any

regression equation derived from this
data set would only be valid with a
force of 500 lbs. The results of this
analysis, Figures 3A to 3D, indicated
that the Power regression yielded the
maximum accountability of variability
(R-squared = 1.0) and thus, the most
valid regression equation. This
equation, Equation (1), was: y1 =
636.62 x1-2, where y1 = pressure (psi)
and x1 = diameter (in).
Step 2A: Establishing Secondary
Variables and Data. It was noted that
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the slope coefficient in the Power
regression equation changed whenever
the Test Force was varied. Consequently, it was deemed that an equation
could be developed to replace the
Equation (1) slope coefficient (636.62)
to overcome the force limiting factor of
the equation. Using the “what if”
capability of Excel, the following table
of Test Force (X) and Slope Coefficient
(Y) data was generated by varying the
Test Force in the Data Table of Primary
Variables and recording the slope

Journal of Industrial Technology

•

Volume 16, Number 4

•

August 2000 to October 2000

•

www.nait.org

coefficient change in the associated
Power regression equation (Figure 3B):
Step 2B: Conducting Regression
Analysis of Test Force (X) and Slope
Coefficient (Y). The basis for this
analysis was to determine the extent of
the relationship between the X and Y
variables in Table 2 as well as a valid
regression approach and equation. The
results of this analysis indicated that
three regression analyses, linear, power,
and polynomial, yielded R-squared
values of 1.0 and any one of these three
could be used. The Power regression
equation detailed in Figure 4, was
selected due to its simplicity. This
equation, y2 = 1.273 x2 where y2 =
forced-based coefficient and x2 = force
(lbs), was labeled Equation (2). The
regression equations of the linear and
polynomial regression analyses that
were not selected for use were, respectively, y2 = 1.273x - 0.0004 and y2 = 9.0E-10x2 + 1.273x - 0.0006.
Step 3: Pressure, Force, Diameter
(PFD) Equation Development.
As mentioned previously, the development of Equation (2) permitted the
replacement of the slope coefficient in
Equation (1) and enabled the determination of pressure at any applied force
and diameter. Algebraically, the
conversion was as follows:
Equation (1)
where,

y1 = 636.62 x1-2
y1 = Pressure (psi)
x1 = Diameter (in)

Equation (2)
where,

y2 = 1.273 x2
y2 = Forced-Based
Coefficient
x2 = Force (lbs.)

Equation (3A)
where,

y1 = y2 * x1-2
Equation (1)
coefficient (636.62)
replaced with y2
equation

Equation (3B)

y1 = (1.273 x2) * x1-2

Figure 1. Trendline Type. To access the trendline type dialog box, create an XY scatter
chart, double click the chart to enter the edit mode, single click on a plotted point, and
select Trendline under the Insert pulldown. Adapted from Microsoft Excel.

Figure 2. Trendline Options. The trendline options dialog box is accessible by
selecting the Options tab whenever the trendline dialog box is displayed. If the
trendline has already been created but needs to be edited, double click the chart to
enter edit mode and double click the regression line. Adapted from Microsoft Excel.

Equation (3C-1) Pressure = 1.273 *
Force * Diameter –2
Table 1. Data Table of Primary Variables

5

Journal of Industrial Technology

•

Volume 16, Number 4

Equation (3C-2) Force = Pressure /
(1.273 * Diameter –2)
Equation (3C-3) Diameter = [ Pressure
/ (1.273 * Force) ] –0.5
Step 4: Pressure, Force, Diameter
(PFD) Equation Validation. Equation
validation is an important aspect,
especially one that incorporates two
regression equations. To validate the
PFD equation, the traditional, two-step
PFA equation was used to calculate the
theoretical pressure that would be
required to lift a force of 500 lbs using
a cylinder with a 2.5 inch diameter
piston. The results of this calculation
were as follows:
Traditional PAF Equation:
Pressure

= Force / Area
= 500 lbs / 4.91 in2
= 101.83 psi

Area

= 0.7854 * (Diameter)2
= 0.7854 * (2.5 in)2
= 4.91 in2

The tradition approach indicated
that a system pressure of approximately
102 psi would be required. Using the
single-step Equation (3C-1), the
theoretical pressure was calculated
using the same force and diameter
values, 500 lbs and 2.5 inch, respectively. The results of this calculation
were as follows:
PFD Equation (3C-1):
Pressure= 1.273 * Force * Diameter –2
= 1.273 * 500 lbs * (2.5 in)-2
= 636.5 * 0.16
= 101.84 psi
The PFD equation indicated that a
theoretical system pressure of approximately 102 psi would also be required
to lift a force of 500 lbs using a cylinder
with a 2.5 inch diameter piston; formula
validation was successful and can be
used in fluid power calculations.

Summary
This paper is intended to aid
professionals in the field into the ways
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and means upon which a spreadsheet
templates can be integrated into a Fluid
Power instruction. The inherent
flexibility and adaptability of spreadsheet templates in data and formuladriven classes make it a useful instructional tool. If spreadsheet integration is
successful, student learning of Fluid
Power concepts can be enhanced;
thereby, strengthening students’
problem solving skills, facilitating
better and faster decision-making, and
increasing the their marketability as
Industrial Technologist. It should also
be noted that the experiences provided
through spreadsheet-based instruction
can provide students with valuable
insight for the utilization of this
software in other classes or on-the-job
before and after graduation.
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